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Directions (Q 1-5) Study the following information
carefully and answer accordingly.

Note: Use additional information given in any
question or its answer for answering subsequent

&

Geography (67)

Economics

English

1. How many students study Geography or English?
a) 108
b) 91
c) 62
d) 130
2. If 32 students study only Geography, how many
students study English?
a) 63
b) 67
c) 52
d) 59
3. How many students study Economics or
Geography or both but not all three?
a) 28
b) 90
c) 68
d) 54
4. How many students study only Economics?
a) 15
b) 16
g 17
d) 18
5. What is the total number of students enrolled for
studying these three subjects, either one of them,
two of them or all of them?
a) 120
b) 130
¢} 123
d) 132

Directions (Q. 6-10) Study the table given below
and answer the following questions. The table gives
the details about bowling performances of six
bowlers. ;

Bowlers | Overs | Maidens Runs Wickets
Conceded | Taken
Lee 20 5 120 15
Bond 18 4 4 9
Steyn -~ 6 -= 20
Asif 12 - -- -
Amir 24 - - 32
Roch i [ s 96 20

Note: Maiden over is one in which a bowler doesn’t
concede any run.

6. If the number of wickets taken by Asif is 16 g%

of total number of wickets taken by all the
remaining bowlers and he conceded 7 runs per over,
then find his strike-rate. (Strike rate is defined as the
no. of runs conceded per wicket)

a) 5.25

b) 4.25

¢) 6.25

d) 7.25
7. How many more maiden overs should Roch have
bowled in order to equal the economy rate of Bond?
(Economy rate is defined as the no. of runs
conceded per over)

a)4

b)6

c)2

d) 8
8. If Amir bowls a maiden for every 3 overs he
bowls and concedes 33 %% more runs that Lee did

then find the ratio of his maidens per wicket to the
runs conceded by him per overs?

a) 5:71

b) 3:71

c) 3:80

d) 5:81
9. If Lee and Steyn collectively bowled 36 overs
and conceded 280 runs, then find the ratio of their

- strike rates. (Use information from previous

questions if needed)
a) 2:1
b) 1:1
o Ll
d) 1:4
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economy rate of Roch? (Use information from
previous questions if needed)

a) 90%

b) 83.33%

c) 85.25%

d) 88.75%

Directions (Q 11-15): Read the given data carefully
and answer the given questions.

Given below is the table which shows the different
types of work A, B, C, D and E; ratio of efficiency
to do these works, of a man, a woman and a child
respectively and total time taken by a child to
complete these different works.

Work Ratio of Time Taken by a child

efficiency to complete work.
(M:W:C)

A 5:3:4 20 days

B 4:3:2 10 days

| 8:7:6 21 days

D 3221 15 days

E 6:4:3 16 days

11. What is the time taken to complete work A by 3
men, 2 woman and 1 child together?

a) More than 4 days

b) More than 5 days

¢) More than 3 days

d) More than 6 days

12. What is the time taken by a Man to complete
Work B?

a) 4 days

b) 10 days

c) 5 days

d) 6 days

13. In how many days can 2 men, 3 women and 3
children complete work D?

a) 6 days

b) 4 days

c) 3 days

d) 1 day
14, Out of works A,B,C,D, which work a man wkes
most days to compleu.

a) A

b) B

c)C

d)D

15. One Man, One Woman and One Child working
together get 1200 Rs in total for completing work A
and 600 Rs for completing work D. What is the
amount received by a child for completing both
works (in Rupees)?

a) 200

b) 300

c) 400

d) 500
Directions (Q. 16-20): Study the given information
and answer the following questions.

There are three types of vehicles i.e., 3 Auto, 4 Car
and one Truck which take rides every day. Distance
covered by each type of vehicle per ride is same.
Profit per ride of an Auto and a Car is given as Rs
20 and Rs 60 respectively and total profit of Truck
in April month is given as Rs 4200. Ratio of total
ride per day of an Auto to total ride per day of a car
is 3:2. Ratio of per ride profit of a Truck to per ride
profit of a car is 70:30 and total proﬁt 1s given as Rs
15980 per day.
16. What is the difference in profit earned by all -
Cars and Truck in one day?
~ a) Rs 13,660
b) Rs 12,120
¢) Rs 14,120
d) Rs 11,380
17.What is the ratio of profit earned by a car in a
day to that earned by an Auto in a day?
a)ll: 9
b)2: 1
c)8:9
d) 13: 9
18. What is the total profit of a single Car Truck
and Auto in a day?
a) Rs 4860
b) Rs 4460
c) Rs 4240
d) Rs 5620
19. What is the contribution of cars(approximately)
to the total income per day in percentage?
a) 68 %
b) 72%
e) 15%: -
d) 82%
20. Whuat 1s the total profit earned by all the Autos
in the month of April?

a) I( (‘)zi”

b) 162,560
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d) 169,200 ' b) 20%
_ c) 25%
Directions (Q 21 -25): The following bar graph d) 30%
shows the Income and Expenditures (in lakhs) 25. Ifthe income of the Company Q in 2000 was
of five companies in the year 2001. 10% less than its income in 2001 and the
The perceat profit or loss of a company is given by 'Company had earned a profit of 10 Lakhs in
Leone o S T 00 2000, then what was its expenditure in 2000(in
income
Lakhs) ?
On the basis of the given data, answer the following a) 28
questions. : b) 30
. c) 32
Income and Expenditure {In Lukhs) of five companies in the year : ' d) 26
ol Directions (Q 26 -30): The following table
L ' E : g gives the percentage distribution of population
5 45 u 45 45— of five states: P, Q, R, S and T on the basis of
0 B s i S o poverty line and also on the basis of gender.
it i 3 T On the basis of the data given in the table chart,
i answer the following questions.
10 ' Proportion of
0 Males and Females
M N P a R Percentage of Balow Above
mExpenditure Oincome | |State| population Below 'poyerty LinePoverty Line
Poverty Line ;
21. What was the percentage profit/loss of the M: F M: F
companies M and N taken together ?
a) 12% loss. P 48 5:6 67
b) 10% loss. Q 20 35 4:5
¢) 10% profit. R 25 2:3 1:2
d) There was no loss or profit. S 19 3: 9 4:5
22.In 2001, what was the approximate T 10 5:3 32

percentage of profit/loss of all the five
Companies taken together ?

a) 4-65% profit. ~ 26. If the male population below poverty line
b) 4615 /1° profit. for the state R is 4 million, then what is the ‘;otal
G e s population of the state R ?

d) 7% loss. e
23. Which company earned the maximum E)) o 2;11;22:

fitin th ?
percentage profit in the year 2001 o) Soimiliion.

a) M s

b) N d) 60 million.

O _

d P 27. What will be the number of females above
24. For the Company R, if the expenditure had the poverty line in the state S, if it is known that
increased by 50% in year 2001 from year 2000 the population of the state S is 100 million ?
and the income increased by 25% in year 2001 a) 57 million.
from year 2000. Then what was the profit b) 45 million.
percentage in the year 2000 ?

¢) 36 million.

~d) 48 million.
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below poverty
line for the state Q is 2.4 million and that for
the state T is 6 million, then what is the ratio of
the total populations of the states Qand T ?

a 1e3
b) 285
¢y 3:7
d 4:9

29. If the male population above poverty line for the
state P is 12 million, then what is the total
population of the state P?

a) 40 million
b) 50 million
¢) 60 million
d) 70 million

30. Using the answers obtained from above four
questions, calculate the ratio of total population of P
to the total population of R?

a) 3:5
b) 5:4
c) 5:6
d) 6:7

LOGICAL REASONING

31. If in a certain code, TREE is written as UQFD,
then how is LEAF written in that code?

a) MFBG
b) MDBE
c) KDZE
d) MBZE

32. A man walks 1 km to East, then he turns to
South and walks 5 kms. Again, he turns to East and
walks 2 kms. After this, he turns to north and walks
9 kms. Now, how far is the man from the starting
point ?

a) 3 kms.
b) 4 kms.
¢) 5kms.
d) 7 kms.

33. Using only 2, 5, 10, 25 and 50 paise coins, what
will be the minimum number of coins required to
pay exactly 78 paise, 69 paise and Rs 1.01 to three
different persons?

a) 19

b) 20
c) 17
d) 18

34. A test has 50 questions. A student scores 1 mark

1 1
for a correct answer, - < for a wrong answer and - -

for not attempting a question. If the net score of a
student is 31, and he has not attempted 6 questions,
then number of questions answered wrongly by that
student is:
a) 6
b) 12
c) 3
d) 9
35. Here are some words translated from an
artificial language.
‘dionot’ means Oak tree
‘blyonot’ means Oak leaf
‘blycrin’ means Maple leaf
Which word could mean “Maple Syrup™?
a) blymuth
b) hupponot
¢) patricrin
d) wellbly

36. If the word ‘EXAMINATION” is coded as
56149512965, then the word ‘GOVERNMENT is
coded as: ' '

a) 7645954552

b) 7654694562

c) 7645965426

d) 7654964526

37. A clock strikes once at 1 o’ clock, twice at 2 0’
clock and so on. If it takes 6 seconds to strike at 3 o’
clock, then in an entire day of 24 hours. How much
time is spent on striking of the Clock?

a) 5 minutes 12 seconds

b) 4 minutes 6 seconds

¢) 3 minutes 20 seconds

d) 5 minutes 32 seconds

38. There are two similar figures below with some
numbers.
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The left one is complete whereas one number is
9&&1§F§1@Muitable number to

fill in the place of the question mark.

a) 280
b) 303
c) 362
d) 382 :
39. Which number should come next in the series:

46, 44,40, 38,34, ...?
a) 28
b) 30
c) 32
d) 36

40. The pair PETAL : FLOWER has certain
relationship to each other. Select the pair
from the options given below with the same
relationship.

a) Pen: Paper

b) Engine: Car

c) Cat: Dog

d) Ball : Game
Directions(Q.41-45): Refer to the following data

and answer the questions that follow.

A numerical machine accepts two values X and Y.
Then it updates these values as

X=XYand Y =Y + 1 in every step.
The machine stops at X > N.

41. For X =3,Y =2 and N = 100, what is the value
of Y when the machine stops?

a)2
b) 3
c)4
d)6

42. In the above question, what is the final value of
X when the machine stops?

a)6

b) 20

c)72

d) 360 :
43. In the above question, what is the value of X
after Step 1?7

a)4

b)5

c)6

d) 20
44. It the value of N is changed to 500, what would
be the final value of X?

a) 3160

b) 2500

¢) 1560

d) 2160
45 1f X =2, Y = 3 and N=500, what would be the
value of X when the value of Y is 77

a) 300

b) 360

c) 720

d) 860

46. Complete the series:
CRDL, EKFL, GKHL, ;
from the options given below.

a) UKL

b) MNOP

c) MNPQ

d) IKJL

47. The pair PAIN:SEDATIVE has certain
relationship to each other. Select the pair
which has the same relationship.

a) comfort : stimulant

b) grief : consolation

¢) trance : narcotic

d) ache : extraction

KKLL

48. Pointing to a woman, a man said, "Her
father is the only son of my father." How is
the man related to the woman ?

a) Brother

b) Grand father

c) Father

d) Son
49. Arrange the following words in a meaningful
sequence.

1.Cow 2.Grass 3.Milk 4. Curd

¥ b L]

2
2!
1
3

-

=8 S8
M‘Ln“-bi—-
r——-huwb-)
o=

] bl -]

50. A man walks 5 km tond south and
then turns to the right. After walking 3 km,
he turnsto the left and walks 5 km. Now,
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a) South
b) South-West
¢) North-East
d) West

51. Pick the odd one out from the given pair of
words. '

a) Docile : Submissive
b) Stringent : Flexible
c) Steadfast : Irresolute
d) Monotonous : Exciting

52. If "HARYANA" is written as "8197151"
in a certain code, then how is "DELHI"
written in that code ?

a) 53289
b) 45389
c) 34589
d) 56789

53. Choose the letter pair which is different from
others in the group.

a) BD
b) IK
¢) PN
d) iSLI

54. Find the missing letters in the series:
DFH, HIL, LNP, , TVX

from the options given below.

a) DTV
b) NRT
¢) PRT
d) RQS

55. Rita told Mani “The girl I met yesterday
at the beach was the youngest daughter of the
brother of my friend’s mother.” How is the
girl related to Rita’s friend ?

a) Cousin

b) Daughter

¢) Mother

d) Aunt

56. Ram is facing north. He then turns 45° in the
clockwise direction and then again turns 180° in the

same direction. He then turns 45° in the anti-

clockwise direction. Find the direction he is facing
now ?

a) East
b) West
¢) North
d) South

57. A dice is numbered from 1 to 6 in different
ways. If 1 is adjacent to 2, 3 and 5, then which
one of the following options is necessarily true ?

a) 1 is adjacent to 4.

b) 2 is adjacent to 5.

c¢) | isadjacent to 6.

d) 4 is adjacent to 6

Directions (Q 58-60) Read the passage given
below. and pick out the correct option for the given
questions.

Five roommates Ranveer, Salman, Tiger, Upen
and Varun each do one housekeeping task:
mopping, sweeping, laundry, vacuuming, or
dusting one day a week, Monday through
Friday.
+ Varun does not vacuum and does not do his
task on Tuesday.
+ Salman does the dusting, and does not do it
on Monday or Friday.
+ The mopping is done on Thursday.
+ Tiger does his task, which is not vacuuming,
on Wednesday.
+ The laundry is done on Friday, and not by
Upen.
« Ranveer does his task on Monday.

58. Which day does Upen do his task ?
a) Friday
b) Thursday
¢) Tuesday
d) Monday
59. What task does Upen do?
a) Mopping
b) Laundry
c) Sweeping
d) Dusting

60. Which day does Salman does his task?
a) Friday '
b) Thursday
¢) Tuesday
d) Monday
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61. What is the value of the following
expression:
[26 + {42 x(23 —20) + 2 —(2 x(5 x 80 —100))
+16 —4}1?

a) —434

b) 434

c) —443

d) —453.

62. What is the number when multiplied by 16
increases by 540 ?

a) 30

b) 36

c) 42

d) 46

63. What is the difference in the place value of 5 in
the numeral 754853 ?

a) 45000

b) 49500

c) 49940

d) 49950

64. If two-third of three-fourth of a number
is 34, then what is the value of 20% of that
number ?

a) 13

b) 13.6

c) 14

d) 14.6

66. The approximate value of
0.4 x0.4+0.04 x0.04 +0.04 is:

a) 0.16

b) 0.20

c) 0.38

-d) 0.46

67. The population of a town is decreasing at a rate of
10% per annum. If the population 2 years ago was

20, 000, then what is the present population ?

a) 15,000
b) 15,200

¢) 16,000
d) 16,200

68. Anil’s salary was Rs.18, 000. An increase of
20% each 1 two consecutive years is equal to a
single increment of what percentage ?

a) 22% :

b) 32%

c) 40%

d) 44%

69. A certain amount of money was invested on
simple interest at a certain rate for 2 years.If it had
been invested at 4% higher rate, then it would have
fetched Rs.480 more, then what is the amount of
money invested?

a) Rs.6, 500

b) Rs.6,000

c) Rs.5,600

d) Rs.5,300

70. On lending a certain sum of money on
compound interest, one gets Rs.9050 in 2 years
and Rs.9500 in 3 years. What is the rate of
interest (approximately)?

a) 6%

b) 5.5%

c) 5%

d) 4.5%

71. X’s and Y ’s shares in a business are in the
ratio of 5 : 3. I[f X has invested Rs.70, 000 for 12
months, then for what period of time Y has
invested Rs.60, 000 ?

a) 6.4 months

b) 7.4 months

¢) 8.4 months

d) 9.4 months

72. The sum of the present age of mother and her
son is 60 years. Six years ago, the age of the
mother was five times the age of her son. What
will be the age of her son after 6years?

a) 23 years

b): 22 years .

c) 21 years

d) 20 years

73. The day on sth April of a year will be the same
day on 5t of which month of the same year ?
a) 5t fune
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£) sth August
d) 5t October

74. A man swims 12 km downstream and 10 km
upstream. If he takes 2 hours each time, then
what is the speed of the stream ?

a) 1.5 km/hr.,

b) 1.7 km/hr.

c) 0.7 km/hr.

d) 0.5 km/hr.

75. How many times the hands of a clock coincide
in a day (or 24 hours) ?

a) 24

b) 23

c) 22

dy 21

76. Sachin scored a ceﬁtury which included 3
fours and 8 sixes. As a result, what percentage of
his total score did Sachin score by running
between the wickets ?

a) 40

b) 45

c) 50

d) 55

77. A pipe can fill a tank in 6 hours and another
pipe can empty the tank in 12 hours. If both the
pipes are opened at the same time, then the tank
can be filled in how many hours ?

a) 10 hours

b) 12 hours

¢) 14 hours

d) 16 hours

78. A man purchases a TV for Rs.8, 000 and sells it
at 10% loss. What is the selling price of the T.V.?

a) Rs.7,200
b) Rs.7,000 -
c) Rs.6,900
d) Rs.6, 500

79. A car takes 2 hours to reach a destination by
travelling at the speed of 60 km/hr. How long (in
hours) will it take when the car travels at the speed
of 80 km/hr?

1
a)l;

1
b) 13

il
C)lg
2

d) -1 -
80. A train is moving at 120 km/hr. The length
of the train is 150 meters. How long it will take
to cross a platform of length 100 meters ? :

a) 7.5 seconds.

b) 10 seconds.

¢) 20 seconds.

d) 25 seconds.

81. P can do a job in 12 days and Q can do the
same job in 10 days. With the help of R,they
can do the same job in 4 days. In how many days
R alone can do this job ?

a) 12 days.

b) 13 days.

¢) 14 days.

d) 15 days.

82. A shopkeeper mixes 60 kg of sugar priced
Rs.30 per kg with 90 kg of sugar priced Rs.40
per kg. At what rate he must sell the mixture to
gain 20% ?

a) Rs.30 per kg.

b) Rs.34 per kg.

¢) Rs.38 per kg.

d) Rs.43.2 per kg.

83.If (v/3)® x 9% = 3* x 34/3, then x equals to :
a) 3
b) 4
c) 5
d) 6

84. The LCM of two prime numbers x and y is
161. If x > y, then the value of 15y — 7x is:

a) —32

b) —56

c) 38

d) 74

85. A blanket, when bleached, decreases in
length by 20% and in breadth by 15%. What is

the percentage decrease in its area ?

a)  32%
b) 35%
c)  42%
d)  45%
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Rs.2 and Re.1 coins. If the number of coins is in
the ratio 4 : 6 : 9 respectively, then what is the
number of 2 rupees coins ?

a) 40

b) 50

c) 60

d) 70

87. In a 100 meters race, P covers the distance in
36 seconds and Q covers in 45 seconds.In this
race, P beats Q by:

a) 9 meters.

b) 20 meters.

c) 22.5 meters.

d) 25 meters.

88. How many numbers from 1 to 20 are cither a
multiple of 3 or 5 ?

a) 9
b) 8
¢} 6
d) 5

89. What is the length of the longest rod that can be

placed in a room 30 meters long, 24 meters broad
and 18 meters high ?

a) 30 meters.

b) 152 meters.

¢) 30vV2 meters.
d) 60 meters.

90. The numerator of a fraction is 3 less than the
denominator. If the numerator be made 3 times
and 20 is added to the denominator, the fraction

1 ’ ;
becomes = What is the fraction?

a)i
b) =
c)-:-
d) =

COMPUTER AND INTERNET

AWARENESS
91. IPv4 address is:
a) 8Dbit
b) 16 bit
¢) 32bit
d) 64 bit

92. Which of the following is used to create or
design a web page?

a) HTML

b) HTTP

¢) PPP

d) WWW

93. An identifier that sends and receives
information across the Internet is called:
a) IP address
b) www
c) Network
d) URL

94. What is the full form of NIC?
a) Network Interconnection Card
b) Network Internet Card
c) Network Interface Card
d) Network Intra Card

95. Which view allows to modify table’s
structure in Access?
a) Design view
b) Datasheet view
¢) Pivot table view
d) Pivot Chart view

96. Which key stroke moves the active cell
towards left in Access table?
a) F2
b) F5
c) Tab
d) Shift + Tab

97. Which combination of key zooms the content
of active cell in Access table?
a). Ctrl +F2
b) Ctrl +F5
c) Shift + F2
d) Shift + F5

98. In MS Access, form dialog may be created
using menu.
a) Create>More Forms>Form
Wizard
b) Create>More Forms>Data Sheet
¢) Create>More Forms>Modal
Dialog
d) Create>Blank Form

99. To open the existing presentation, press:
a) Ctrl + L
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d) Ctrl + O

100. The File that consists of readymade styles that
we can easily use for our presentation is known as:

a) Pre formatting
b) Template

¢) Wizard

d) AutoStyle

101. In Microsoft PowerPoint in order to see all the
slides on one screen use:

a) view slide sorter

b) view slide

c) view master

d) view slide show

102. Which is the menu command to recolor a
picture on a slide?

a) Insert -> Picture -> Recolor

b) Tools -> Picture -> Recolor

¢) Format -> Picture -> Recolor

d) Edit -> Picture -> Recolor

103. How can you update the values of formula
cells if Auto Calculate mode of Excel is disabled?
a) F8 '

b) F9

c) F10

d) F11

104. You can convert existing excel worksheet data
and charts to an HTML document by using:

a) FTP wizard

b) Internet assistant wizard

¢) Intranet wizard

d) Import wizard

105. What is the short cut key to highlight the entire
column in Excel?

a)Ctrl+C

b) Ctrl + Enter

¢) Ctrl + Page Up

d) Ctrl + Space Bar

106. Which of the following is an example of Page
Orientation?

a) Landscape

b) Subscript

¢) Superscript

d) A4

107. You can Select all the text in MS Word
document by:

a) Ctrl +S

b) Ctrl + A

c) Ctrl+V

d) Ctrl + 1

108. How can you apply exactly the same
formatting you did to another text in MS-word?
a) Copy the text and paste in new location. Then
type the new text again

b) Copy the text and click on Paste Special tool in
new place :

c) Select the text then click on Format Painter and
select the new text

d) All of above

109. To use your keyboard instead of the mouse to
select tools on the ribbon, you display the KeyTips
by pressing the key.

a) Alt

b) Ctrl

c) Shift + Enter

d) Alt + Enter

110. If you need to change the typeface of a
document, which menu will you choose?

a) Edit

b) View

c¢) Format

d) Tools

CURRENT AFFAIRS

111. Where is India’s largest facility for
weightlifting coming up?

a) Ganjam

b) Imphal

¢) New Delhi
d) Bhubaneswar

112. Who won the Best Actress award at Cannes
Film Festival 2024 for acting in film ‘The
shameless’ (royal section)?

a) Kani Kusruthi
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d) Chhaya Kadam

113. Naomi Osaka, famous tennis player returned
to WTA Tour after a break in January 2024. Why
did she take the break?

a)  Injury

b) Mental health issues

¢) Financial issues

d) Legal issues (court case)

114. Ameen Sayani died in February 2024. In which
field did he earn his fame?

a) Radio announcement
b) Singing

¢) TV Anchor

d) Film Director

115. Manohar Joshi died in February 2024, For
which period was he speaker of the Lok Sabha.

a) 2002 to 2004
b) 2004 to 2006
¢) 2000 to 2002
d) 1995 to 2000

116. Who is the Solicitor General of India?

a) Tushar Mehta

b) Ranjit Kumar

¢) Mohan Parasaran
d) Gopal Subramanyam

117. Who is the current Chairman of Security and
Exchange Board of India?

a) Madhabi Puri Buch
b) V.K Sinha
c) Ajay Tyagi
d) C.B Bhave

118. Who is the chief of Army Staff in June, 20247

a) General Manoj Pande

b) General Manoj M. Naravane
¢) General Dalbir Singh Suhag
d) General Rakesh Kapoor

119. Who is the president of Pakistan?

a) Asif Ali Zardari
b) Imran Khan

¢) Nawaz Sharif
d) Shahbaz Sharif

120. Palestinianr Prime Minister declared his
resignation in end February and laid down office on
31% march 2024. What is his name?

a) Mohammad Shtayyeh
b) Rami Hamdallan

¢) Salam Fayyad

d) Yehia Sinwar

121. Who is the new Prime Minister of Singapore?

a) Lawrence Wong
b) Lee Kuan Yew
¢) Gok Chok Tong
d) Lee Hsien Loong

122. Alice Munro died in May 2024. In which field
did she earn her fame?

a) Literature
b) Acting
c) Painting
d) Politics

123. Director of “All We Imagine as Light” won the
Grand Prix at Cannes Film Festival 2024. Who is
the Director of the film?

a) Sanjay Leela Bhansali
b) Payal Kapadia
¢) Mani Ratnam
d) Anurag Basu

124. New laws replacing IPC, Cr.PC and IEA will
come into effect on: :

a) July 12024

b) June 1 2024

¢) 31 December 2024
d) 1 January 2025

125. Result of votes counting in which election was
set aside by Supreme Court in February 20247

a) Election for Mayor of Chandigarh.

b) Election of Rajya Sabha in Uttar Pradesh

¢) Election of MLA in a recent election.

d) Election of Rajya Sabha in Himachal
Pradesh.

126. Cyclone ‘REMAL’ made landfall in end May.
Which country was most affected by ‘REMAL’?
a) Bangladesh
b) Myanmar
¢) Thailand
d) Sri Lanka
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Legislative Assembly?

a) 137
b) 147
) 157
d) 142

128. Who is the present Chief Minister of Goa?

a) Pramod Sawant

b) Digambar Mamat

c) Laxmikant Parsekar
d) Francisco Sardinaa

129. What is the name of Slovakia Prjme Minister
who was attacked in May 20247

a) Peter Pellegini
b) Robert Fico

c) Eduard Heger
d) Ludovit Odor

130. Who is the Chairman of DRDO and Secretary
of Department of Defence Research &
Development?

a) Dr. Samir V. Kamat
b) Shri S. Christophar
¢) Dr V.S Arunachalam

~ d) Dr. G. Satheesh Reddy

'131. Who is the Director General of CSIR and
Secretary of DSIR?

a) Dr. (Mrs) N Kalaiselvi
b) Dr. R.A Mashelkar

¢) Dr. Sekhar C Mande
d) Dr. Girish Sahani

132. Which Covid vaccine manufacturer admitted
in UK Court that said vaccine can in rare cases
cause “Thrombosis with Thrombocytopenia
syndrome”?

a) Astra Zeneca/Covishield
b) Covaxin

c) Sputnik -V

d) Janssen

133. Which is India’s largest Lok Sabha
constituency in terms of voter population?

a) Malkajgiri
b) Outer Delhi
c) Agra

d) Khurda

134. Papua New Guinea was affected by a natural
disaster in May 2024 resulting in death of over a
thousand. What was the national disaster?

a) Cyclone
b) Flood

¢) Landslide
d) Earthquake

135. In Archery World Cup, held recently at
Shanghai, Indian Women’s team won Gold Medal.
Whom did they defeat in final?

a) Turkey

b) France

c) Italy

d) South Korea

136. Alejandra Rodriguez, a lawyer and journalist
recently won title of Miss Universe Buenos Aires.
What was her age at the time of winning the title?

ay 27

b) 45

€) 25

d) 60

137. A biopic ‘Chamkila’ was made on life of Amar
Singh Chamkila. In what field did late Mr. Amar
Singh Chamkila earn his fame?

a) Singing
b) Sports
¢) Dance
d) Literature

138. In India Super League, whom did Odisha FC
face in semifinal in April 2024?

a) Mohan Bagan
b) Mumbai city

¢) Kerala Blasters
d) Goa

139. Who is the Captain of Kolkata Knight Riders,
who won IPL Championship in 2024?

a) Shreyas lyer
b) Andre Russel
c) Phil Salt A
d) Varun Chakravarthy

140. Who has been awarded Gyanpith Puraskar for
20237

a) Gulzar

b) Rambhadracharya

c) Botha&b

d) None of the above
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a) Paradeep Port
b) Kandhra Port
¢) Vizag Port
d) JNPA Port

142. As per recent amendment made in Section 14
(b) of Representation of People Act, how many
qualifying dates have come into effect, in place of
one qualifying date, for voter registration?

a) 2

b) 3

c) 4

d) 5

143. On which date is National Voters Day
celebrated in India?

a) 24 January
b) 25 January
¢) 26 January
d) 26 February

144. As per new initiative by ECI, senior citizens
above certain age can vote from home. What is that
age? -

a) Above 80 years
b) Above 85 years
c) Above 75 years
d) Above 82 years

145. ECI has approved 12 alternative identity
documents in place of Voter Identity Card for
identity verification at Polling Booth. Which of the
following is not one of them?

a) PAN Card

b) AADHAR Card

¢) Credit Card

d) Driving license

146. What percentage of booths are covered for
webcasting by ECI? -
a) 30%
b) 40%
c) 50%
d) 60%

148. In how many phases has General Election

2024 been conducted in Odisha?

a) 3 Phases
b) 4 Phases
c) 5 Phases
d) 2 Phases

149. Prime Minister of Greece paid state visit to
India in March 2024. What is his name?

a) Kyriakos Mitsotakis

b) Alexis Tsipras

c) loannis Sarmas

d) Kostis Hatzidakis

150. Kolkata Knight Riders won IPL title in 2024.
Who did they defeat in the finals?

a) Mumbai Indians

b) Sunrisers Hyderabad

¢) Royal Challengers Bengaluru
d) Rajasthan Royals
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